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ABSTRACT 

Demands in oil and gas industries on reliable quality of inspection in pipeline 

operation is increasing throughout the year, although intelligent PIGs are more 

capable than simpler conventional counterparts, they still have several setbacks such 

as cannot clean throughout the pipeline while inspection and only can move in 

several distance in a single flow. Pipeline is the most important medium to transport 

crude oil and gas to the terminal. In order to maintain the efficiency of the 

transportation, Conventional PIG is the best solution that can act as a pipeline cleaner 

and also Intelligent PIG as a pipeline inspector to detect any corrosion and leakage. 

A proper research work has been made, an improvement in which a prototype of an 

Intelligent PIG is developed with respect to the benchmarked of the pipeline crawler 

drive mechanism to clean and inspect throughout the oil and gas pipeline on entering 

and leaving the pipeline from a single exit. 

This project is aimed to develop the assembly of a CAD-based model of an 

experimental intelligent PIG drive mechanism and simulate to show that the PIG 

model is able to travel in both contra-flow and in-flow direction based on the 

research work that has been made. CATIA software was used to review and 

developed the CAD-based model assembly on changing all constrains to meet the 

specific requirements. Meanwhile, for simulations using DMU Kinematics was used 

to demonstrate the movement of the PIG drive mechanism in a pipeline using a 

suitable joints and constrains. 

The final outcome of this project is a demonstration of the experimental PIG crawler 

drive mechanism CAD-based model assembly are correctly develop with the suitable 

constrains and shows that the PIG travel in the pipeline on both contra-flow and in-

flow direction. 
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CHAPTER 1 

INTRODUCTION 

1.1 Background 

PIG is known as Pipeline Inspection Gauge which is inserted into the pipeline and 

travels throughout its entire length. There are two types of PIG that are usually used 

by companies to maintain the efficiency of the production pipeline that is 

conventional pigging that cleans the pipeline from any disturbances, and Intelligent 

PIG that inspects the condition of the pipeline. Common PIG usually propelled by 

the pressure of the flowing fluid or gases. Nowadays, demands on reliable quality of 

inspection in pipeline operation is increasing throughout the year, although 

intelligent PIGs are more capable than simpler conventional counterparts, they still 

have several setbacks [1]. 

In order to overcome such difficulties in pigging, several developments of contra-

flow crawler was made with the purpose of entering and leaving the pipeline from a 

single exit.  The crawler crawls in the contra-flow direction and returns to the flow 

after the return mechanism is triggered in special conditions at the end of the 

pipeline. 

 

 

 

 

 

 

 

 

 

 

 



 

2 

 

1.2 Problem Statement 

Based on a previous research, Kresnajaya [2] has proposed a PIG design in which the 

force exerted by the fluid energy was converted into rotational energy through the 

turbine impeller. Meanwhile, Azmi [3] had improved the design based on calculation 

and theoretical assumption. Based on the improvement, an Intelligent PIG prototype 

is developed with respect to the benchmarked of the pipeline crawler drive 

mechanism. Therefore, modeling and simulation of the PIG has to be analyzed to 

determine whether the PIG crawler drive mechanism can travel in both contra-flow 

and in-flow directions.  

 

Figure 1: Photo shot of PIG prototype design assembly arrangement. [4] 

 

1.3 Objectives 

i) To develop the assembly of a CAD-based model of an experimental 

intelligent PIG using CATIA software. 

ii) To simulate forward and reverse drive mechanism movement of the PIG 

model that able to travel in both contra-flow and in-flow direction using 

DMU kinematics in CATIA software. 
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1.4 Scope of Work 

i) To analyze and improvised all the assembly constrains of the CAD-

based model drive mechanism of an intelligent PIG to meet the 

specific requirements using CATIA software. 

ii) To simulate the drive mechanism movement using joints and 

constrains of DMU kinematic in CATIA software to meet the 

functional requirements of the PIG model. 
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CHAPTER 2 

LITERATURE REVIEW 

The literature review of this research work will be divided into two categories which 

are (1) Drive mechanism and turbine module of an Intelligent PIG, (2) Modeling and 

Simulation using the CATIA CAD software. 

2.1 Drive mechanism and turbine module of an Intelligent PIG 

The latest development of pipeline contra-flow crawler is reported in [5]. The 

working principle for this crawler is that the equipped battery will power the 

electromotor via the gear reducer. Then, torque produced will be transferred to the 

drive shaft which consists of a double - screw. The structure of this development is 

stated in figure 2 below, that contains; 1-pipeline, 2- supporting wheel, 3-slip, 4- 

supporting bar, 5-Spring, 6-nut, 7- drive shaft, 8-crawlingcube, 9-gear reducer, 10-

electromotor, 11-wire, 12-battery. 

 

Figure 2: Design of the New Contra-Flow Crawler. [5] 

The movement of the crawler is fragmented into two mechanism stages in one cycle 

motion. The nut and supporting bar's movement are synchronized when the nut 

moves from the left side of the head to the right side of the head. It will be moving in 

a contra - flow direction. When the nut reaches the right side of the head it will 
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automatically enters reverse screw direction that direct it back to the left head 

meanwhile the supporting bar fixed on the crawling tube.  The mechanism that 

travels contra-flow is because of the reacting force between the nut and shaft.  

This concept was generated based on an invention produced from a joint effort 

between Astec Developments Ltd. Corporation and Subsea Integrated Group (SIG) 

with Durham Pipeline Technology (DPT). 

 

Figure 3: Contraflow Tetherless Mechanical Pipeline Crawler. [1] 

The crawler concept of Astec Development consists of four major modules: (1) 

turbine module, (2) tractor module, (3) wax cutting module, and (4) return module. 

The wheel supported tractor is energized by the turbine. Oscillate movement of 

forward, backward, outward and inward is controlled by elastic leg on the supporting 

wheels. The return spring-valve will close when the crawler is being triggered and a 

large pressure drop emerges that can push the PIG return with enough friction.  

 

Figure 4: 10" Genesis SIG Tool. [6] 

Genesis SIG tool is a tethered crawler powered by electric linear drive reciprocators. 

The main drive for this PIG is sliding brushes which are mounted on the electric 

linear drive. At the starting position the brush will point backwards. Both of front 

brush will drive the PIG contra-flow while the back brush is to hold the position of 

the PIG with lower sliding resistance than the brushes on the power stroke. 
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Table 1: Summary of Chronological Developments of Contra-Flow Crawler 1. 

Crawler 
Type 

Mechanism 
Actuator 

Pattern of 
Movement 

Means of 
Power Source 

Direction of 
Crawler 

Type of Drive Production Flow Crawler Motion 

Novel self-
drive PIG 
2005 [7] 

Turbine 
driven 

brushes via 
double-
screw 
thread 

Crawling Tetherless Bidirectional  Self-Drive Uninterrupted Continuous 

ThruFlow 
2010 [1] 

Electric 
linear driven 

brushes 
Crawling Tethered Bidirectional  Self-Drive Uninterrupted Continuous 

New 
contra-flow 

Crawler 
2011 [6] 

Battery 
powered 

electromoto
r driven 

brushes via 
double 
screw 

Crawling Tetherless Bidirectional  Self-Drive Uninterrupted Continuous 

 

2.2 Modeling and Simulation using CATIA CAD software 

CATIA is a high end classification Computer Aided Design (CAD) software tool that 

can be used to provide a suite of surfacing, reverse engineering, and visualization 

solutions to create, modify, and validate complex innovative shapes. DMU 

Kinematics is a simulation program that can be done in CATIA to show the 

mechanism motion, moving parts, assembly constrain and mechanism analysis of the 

CAD model. 

Modelling processes: 

1) Sketch 

Sketch is the starting step to draw the base shape of the component with 

required diameter on a specific plane by using either random sketch or with 

extra features such as 2D fillet, chamfer, circle, eclipse, etc. 

http://en.wikipedia.org/wiki/Reverse_engineering
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Figure 5: Sketching process. [8] 

2) Part Design 

This process is the 3D shaping part that will be extruded from the base sketch 

from process 1. From an extruded shape, the part can be modified by using 

extra features same as process 1. The difference is that these adjustments 

need to be made on the shape of the part that requires isometric view. 

Meanwhile, process 1 was only to consider on a 2D sketch base with front, 

left, right and bottom view. 

 

Figure 6: 3D Part design process. [8] 
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3) Assembly Design 

Assembly is where all the parts that were produced are combined together 

with a feature known as “Coincident Constrain”. 

 

Figure 7: Assembly of 3D parts. [9] 
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DMU Kinematic is divided into two types of simulation, they are simulation with 

law and simulation with command [10]. For every simulation a variable need to be 

determined, depending on the requirement of the toolbar of the specified simulation. 

Below is an example of simulation with command and the example of the basic 

simulation assembly process corresponding to the kinematics mechanism. 

1) Entering the Workbench 

i. Select Digital Mockup -> DMU Kinematics from the Start menu. The 

DMU Kinematics workbench is loaded and an empty document 

opens. 

 

Figure 8: Select DMU Kinematics. [10] 

ii. Select File -> Open from the menu bar 

iii. Select the rods.CATProduct document. Click Open to open the 

selected file. The specification tree is displayed showing all the 

selected products. 
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Figure 9: Open File. [10] 

iv. Select the products in the tree, then select Edit -> Design Mode. Now 

expand the tree to show all the design components of the products. 

 

Figure 10: Expand tree. [10] 
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2) Defining a Command 

i. Double-click the joint 3 in the specification tree. The Joint Edition 

dialog box is displayed. 

 

Figure 11: Specification tree. [10] 

 

 

Figure 12: Dialog box. [10] 
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ii. Activate the Driven angle option. The command will be an angle type 

command. 

 

Figure 13: Command. [10] 

iii. Click Ok to confirm your operation. The command is identified in the 

specification tree. 
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3) Defining a Fixed Part 

i. Click the Fixed Part icon from the DMU Kinematics toolbar or select 

Insert->New Fixed Part from the menu bar. The New Fixed Part 

dialog box is displayed. 

 

Figure 14: New Fixed Part dialog box. [10] 

ii. Select the Fixed Part either in the geometry area or in the specification 

tree. 

 

Figure 15: Select Fixed Part. [10] 
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iii. The fixed Part is automatically defined. 

 

Figure 16: The fixed part is identified in the specification tree. [10] 
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4) Simulation the result 

i. Click the Simulation with Commands icon. The Kinematic Simulation 

dialog box displays: The command of the kinematics mechanism are 

available as shown opposite. 

 

Figure 17: DMU Kinematics Command. [10] 

ii. Manipulate the slider of the command. The kinematics mechanism 

moves accordingly. 

 

 

Figure 18: Kinematics mechanism movements command. [10] 
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iii. Use the manipulator in the geometry area. Move the mouse over a 

joint. The driven joint highlights and the manipulator appears. Drag 

the model with the left mouse button. 

 

Figure 19: Driven joint manipulator. [10] 
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CHAPTER 3 

METHODOLOGY 

3.1 Introduction 

This project focuses on the main parts of the experimental PIG that is the drive 

mechanism, turbine module and Universal joint. Knowledge and research that was 

gained during the earlier stage of this project gave the idea to produce a flow chart 

that comprises of all the stages of task involved during modeling and simulation. 

This project will consider the calculation by Kresnajaya [2] and drive mechanism 

movement analysis by Azmi [3] in operating and defining the drive mechanism 

simulation constrain. 

 

3.2 Project Flow Chart 

Figure 20 shows the key stages of the project undertaken, the main key stages are: 

i. Preliminary research work / Literature review 

ii. Modeling development / Correction 

iii. Simulation 
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Figure 20: Flowchart of PIG Simulation 
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TM UJ 

The first stage to conduct this research is to understand the existing PIG CAD model 

and prototype in term of calculation and drive mechanism. Design of the CAD model 

needs to be checked with existing prototype so that it matches the assembly criteria. 

If any problems were identified in the PIG design assembly, corrections will be 

made. This cycle will be repeated until the assembly requirement is reached. 

 

(i) 

 

(ii) 

Figure 21: Complete modelling of PIG and Prototype design. [4], [7] 

 

 

Figure 22: Drive Mechanism module with aligned holder bar. [7] 

 

 

 

FCM 
DMM 
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The second stage of the research work is to compare the existing PIG with similar 

work by experts on theoretical analysis data such as technical specification, data 

collection and data analysis. Calculation and analysis by Kresnajaya [2]. 

Rotational speed of the drive mechanism is: 

ωDM = vn . 2.π / I 

Where ωDM is the rotational speed of the drive mechanism, vn (= 0.033 m/s) is the 

desired PIG speed, and I is the pitch of the double screw. 

Time of the follower (moving brush) to travel along the entire length of double screw 

in one cycle motion is: 

tn = L / vn = L.2.π / ωDM. I 

Where tn is the time of the follower to travel along the entire length of double screw 

in one cycle motion, L is the length of the double screw, ωDM is the rotational speed 

of the drive mechanism, and I is the pitch of the double screw. 

The time of drive mechanism to travel forward in one cycle motion is: 

tm = L / vm = L.2.π / (ωDM)p. I 

Based on the value of L = 150mm and I = 10 mm, the calculated results is 

summarized in table 2. 
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Table 2: Calculated result of follower travelling time, drive mechanism time in one 

cycle motion, rotational speed of follower and drive mechanism. 

Descriptions Results Remarks 

Follower travelling time, tn 1.052 s  

Drive mechanism time, tm 4.5 s  

Rotational speed of follower, ωDM 89.51 rad / 

s 

Rotational speed of double 

thread screw when moving 

brush moving forward 

Rotational speed of drive mechanism, 

(ωDM)p .  

21 rad / s Rotational speed of double 

thread screw when PIG 

body moving forward 

 

With the calculated propulsion force of 2114.95 N by the drive mechanism, the PIG 

design is capable to travel with a speed of 0.033 m/s in both directions. 

This is the crucial step that needs to be done before simulation of PIG is conducted. 

The result of the simulation will be evaluated and if it didn’t meet the design 

requirement, PIG analysis data need to be validated again before dissertation write 

up/completion. The cycle will continue to reach the required specification. 
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In Progress 

Table 3: Gantt chart 

 

FYP Schedule Timeline 

FYP I 

( 20 May – 23 Aug 2013 ) 

FYP 2 

( 23 Sept – 27 Dec 2013 ) 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 

Introduction 

*Understanding Project 

Description/existing crawler PIG model 

                            

2 

Literature Review 

*Research on drive mechanism and 

  turbine module of an Intelligent Pigging 

*Research on Modelling and 

  Simulation on CATIA. 

                            

3 
Develop CAD model assembly 

*Assemble PIG model in CATIA 

                            

4 

Simulation of PIG design model in 

CATIA 

*Validation Theoretical Analysis 

*Technical Specification/ Data collection 

*Data analysis 

*PIG design simulation 

                            

5 Dissertation write up 

                            

Completed To be done Milestone 
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CHAPTER 4 

RESULT AND DISCUSSION 

4.1 Modeling (Develop CAD-based model assembly) 

In Final Year Project 1, a CAD-based model assembly was analyzed and corrected 

using CATIA V5R20 software. All the parts were developed and assembled by Azmi 

[3], with the formula function by Kresnajaya [2]. From the assembly, few 

measurement were adjusted before simulation was made and that is the main scope 

of work for this paper work. If one of the parameter changed the assembly will be 

scattered around because all the parts were link with each other. Figure 14 show the 

complete assembly after analyze and correction. 

 

Figure 23: Complete model of PIG drive mechanism after correction. 
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To accomplish the assembly as figure 14 several steps need to be taken. Each of this 

assembly need to be carefully connected so that it won’t scattered when it is being 

updated or simulated. 

The steps are: 

1) Analyse all constrain of the assembly. 

 

Figure 24: Correction need to be change on CAD-based model. 

2) Deleting the constrain link on each assembly. 

 

Figure 25: Deleting link on assembly. 
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3) Assembly with new constrain and attach it to the drive mechanism 

assembly. 

 

Figure 26: Assembly with new link. 

 

 

Figure 27: Assemble drive mechanism with new link. 
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Figure 28: Complete new assembly link for drive mechanism. 

 

4.2 Simulations (DMU Kinematics) 

Simulation of the PIG models are made using CATIA V5R20 software and all the 

specifications and assembly were based on to literature review from previous 

researcher. Using DMU Kinematics in CATIA V5R20, before applying the 

calculation in the simulation, constrain and command need to be determine on each 

part of the assembly such as Fix, Revolve Joint, Prismatic Joint, Cylindrical Joint, 

Screw Joint, Spherical Joint, Planar Joint, Rigid Joint, Point Curve Joint, Slide Curve 

Joint, Roll Curve joint, Point Surface Joint, universal Joint, CV Joint, Gear Joint, 

Rack Joint, Cable Joint and Axis Based Joint. This simulation are divided into four 

main mechanism that are: 

i. Moving bristle movement for mechanism 1 

ii. Forward movement of the PIG for mechanism 2 

iii. Poppet movement for mechanism 3  

iv. Backward movement of the PIG for mechanism 4.  
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4.2.1 Moving bristle movement for mechanism 1 

Main objective for mechanism 1 is to show the moving bristle moved on the thread 

when the turbine blade were spinning by the pipeline flow. This mechanism are 

determined by 7 command containing three joints which are Fix, Revolve Joint and 

Prismatic Joint.  

 

Figure 29: Mechanism 1. 

Steps on determining command for mechanism 1 are shown below: 

1) Insert PIG assembly and change the setting to DMU Kinematics at Start > 

Digital Mockup > DMU Kinematics.  

 

Figure 30: Change to DMU Kinematics Settings. 
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2) The first command is to select the Harmonic gear as fix part and create a new 

mechanism before determining the fix component. This fix feather is used as 

a reference point for any joint so that they will be in the same angle and 

length movement. 

 

Figure 31: Create new mechanism and Fix part. 

3) First revolve joint is determined between the harmonic gear as fix part and 

the Turbine blade. The criteria for this joint was that the harmonic gear and 

Turbine blade lie in the same line and plane. Angle driven need to be check to 

determine it’s a rotational movement by angle. 

 

Figure 32: Revolve joint for Harmonic gear and Turbine blade. 
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4) The third command is for the second revolve joint for HUB and Harmonic 

gear. Line and plane was determined for each component and select angle 

driven for the rotational via angle. The HUB and shaft had to be determined 

differently because CATIA detect the component as a stand-alone part. 

 

Figure 33: Revolve joint for Harmonic gear and HUD. 

5) Repeat step 4 for Universal joint with Harmonic gear, Cam with Harmonic 

gear and Shaft with Harmonic gear. 

 

Figure 34: Revolve joint for Harmonic gear and Universal joint. 
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Figure 35: Revolve joint for Harmonic gear and Cam. 

 

Figure 36: Revolve joint for Harmonic gear and Shaft. 

6) Last command for mechanism 1 is the Prismatic joint for Harmonic gear and 

Moving bristle. The criteria for this joint is the line and surface of the 

movement via the yz axis. This joint is moved based on length determined on 

the simulation control box. 
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Figure 37: Prismatic joint for Harmonic gear and moving bristle. 

7) When all of the commands were defined and all constrain were made sure not 

to be redundant, a notification box will appear and said that the mechanism 

can be simulated. 

 

Figure 38: Mechanism can be simulated. 

The last step on simulation is to adjust the settings in the command box. The 

first value that had to be determined is the length of the thread that is 150mm 

with 15 pitch for the moving bristle path. Meanwhile rotational angle for 

other command are determined with the equal speed that need to be find 

while simulating. The value that can correlate with the Moving bristle are 

5400 for rotational angle (15 pitch X 360 degrees/pitch = 5400). 
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Figure 39: Simulation value command. 

4.2.2 Forward movement of the PIG for mechanism 2. 

Main objective for mechanism 2 was to show the PIG move forward while the 

moving bristle stays at the current position. This mechanism are determined by 12 

command containing three joint that is Fix, Revolve Joint and Prismatic Joint. The 

command is the same as mechanism 1 but this is longer because in mechanism 1 only 

shows the movement of the moving bristle meanwhile for mechanism 2 was to show 

the movement of the PIG forward. 

 

Figure 40: Mechanism 2. 
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Steps on determining command for mechanism 2 are shown below: 

1) Create new mechanism and fix part for this mechanism is the moving bristle. 

Determining the rotational angle command is the same as step 3 – 5 in 

mechanism 1.  

2) Prismatic Joint are defined between moving bristle as the fix part with the 

turbine casing, poppet casing and the holder bar with brush holder assembly 

on the yz plane. 

 

Figure 41: Prismatic joint for moving bristle and turbine casing. 

 

Figure 42: Prismatic joint for moving bristle and poppet casing. 
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Figure 43: Prismatic joint for moving bristle and holder bar with brush holder. 

3) Last step is the same as step 7 in mechanism 1 which were to define the value 

of each command depending on the suitable rotational, length and speed 

constrain. 

 

Figure 44: Settings for mechanism 2. 
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4.2.3 Poppet movement for mechanism 3. 

Main objective for mechanism 3 is to show the poppet movement on blocking the 

pipeline flow and to allow the flow to enter PIG to rotate the turbine blade. This 

mechanism are determined by only 1 command that was the Prismatic Joint.  

 

Figure 45: Mechanism 3. 

Steps on determining the command for mechanism 3 was by using prismatic joint 

between Poppet and Turbine casing as the fix part. 

 

Figure 46: Prismatic joint for Poppet and Turbine casing. 
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Value for prismatic joint of mechanism 3 was only 6.55 because that is the only 

allowable gap that found through simulating. 

 

Figure 47: Settings for mechanism 3. 
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4.2.4 Backward movement of the PIG for mechanism 4. 

Main objective for mechanism 4 was to show the PIG move backward while all the 

parts stays at the current position. This mechanism are determined by 12 commands 

containing only two joints that were Fix and Prismatic Joint. The command is almost 

the same as mechanism 2 but this mechanism only use prismatic joint to show the 

backward movement in static position without any rotational angle. 

 

Figure 48: Mechanism 4. 

Steps on determining command for mechanism 4 are shown below: 

1) Pipeline is defined as Fix part because only the PIG are moving. 

 

Figure 49: Pipeline as fix part. 
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2) All assemblies and stand-alone parts were defined as prismatic joint with the 

pipeline to get the same result on speed and length while simulating. The 

parts were:- 

i. Moving Bristle 

ii. Assembly Bar and Brush holder 

iii. Shaft (x2) 

iv. Universal Joint 

v. HUB 

vi. Turbine Blade 

vii. Harmonic Gear 

viii. Turbine Casing 

ix. Poppet Casing 

x. Poppet assembly 

xi. Cam and Bearing assembly 

 

Figure 50: Example Prismatic joint for mechanism 4 (Moving Bristle with Pipeline). 
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3) Lastly, after defining all constrains and commands of mechanism 4 the value 

will be assume as 150 because of the distance of the pipeline in the 3D model 

and enough to show how the PIG move backward when the Poppet close the 

flow of the PIG.  

 

Figure 51: Settings for mechanism 4. 

4.3 Discussion and Limitation 

All the mechanism were successfully simulated to show the PIG can travel in in-flow 

and contra-flow movement. But to get the accurate value as calculated by Kresnajaya 

[2] were hardly to be defined with several limitation that are:- 

i. Double thread was hard to define and it needs further in-depth research 

and simulation, to show if it can be used for reverse and forward 

movement. 

ii. Lack of time, guides (experts) and knowledge to implement several 

previous calculation by Kresnajaya [2] in the simulation. 
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CHAPTER 5 

CONCLUSION AND RECOMMENDATIONS 

Throughout this research of the project, the author has looked for several approaches 

and alternatives in order to implement the right procedure and simulation for this 

project. During the development stage, experimental PIG drive mechanism assembly 

was developed and simulated in CATIA software.  

5.1 Conclusion 

In conclusion the author had completely corrected the experimental PIG crawler 

drive mechanism CAD-based model assembly with the suitable constrains.  In this 

process there are important steps that need to be taken to achieve the correct 

assembly and meet the specific requirement by Azmi [3]. The steps is to analyse the 

CAD-based model assembly constrains, improvements was made if the constrain 

didn’t meet the requirement by deleting those constrain link and assemble it with a 

new constrains. There were several problems occurs when determining the assembly 

between the Moving Bristle and Cam that is to assemble the Follower on the Double 

Thread. The Double Thread being detect as a whole and cannot detect as a line itself. 

So, the follower cannot be coincident between the double thread. To solve this 

problem the author had to check the assembly requirements data and defined the 

Follower as a distance coincident between Moving Bristle and Drive Bristle as long 

the Follower is between the Double Thread with the correct distance. Meanwhile, the 

other component are successfully assembled. 

Secondly, the author successfully simulated and shows the forward and backward 

drive mechanism movement of the PIG that travel in the pipeline on both contra-flow 

and in-flow directions. To show simulated movement in DMU Kinematics there are 

features and joints that need to be determined such as Fix, Revolve Joint, Prismatic 

Joint, Cylindrical Joint, Screw Joint, Spherical Joint, Planar Joint, Rigid Joint, Point 

Curve Joint, Slide Curve Joint, Roll Curve joint, Point Surface Joint, universal Joint, 
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CV Joint, Gear Joint, Rack Joint, Cable Joint and Axis Based Joint. But for this 

project the author only used Fix, Revolve Joint and Prismatic Joint. This simulation 

are divided into four main mechanism that are: 

i. Moving bristle movement for mechanism 1. 

Main objective for mechanism 1 is to show the moving bristle moved on the 

thread when the turbine blade are spin by the pipeline flow. This mechanism 

are determined by 7 command containing three joint that is Fix, Revolve Joint 

and Prismatic Joint. 

ii. Forward movement of the PIG for mechanism 2. 

Main objective for mechanism 2 is to show the PIG move forward while the 

moving bristle stays at the current position. This mechanism are determined 

by 12 command containing three joint that is Fix, Revolve Joint and Prismatic 

Joint. The command is the same as mechanism 1 but this is longer because in 

mechanism 1 only shows the movement of the moving bristle meanwhile for 

mechanism 2 is to show the movement of the PIG forward. 

iii. Poppet movement for mechanism 3. 

Main objective for mechanism 3 is to show the poppet movement on blocking 

the pipeline flow and to allow the flow to enter the PIG to rotate the turbine 

blade. This mechanism are determined by only 1 command that is the 

Prismatic Joint.  

iv. Backward movement of the PIG for mechanism 4.  

Main objective for mechanism 4 is to show the PIG move backward while all 

the parts stays at the current position. This mechanism are determined by 12 

command containing only two joint that are Fix and Prismatic Joint. The 

command is almost the same as mechanism 2 but this mechanism only use 

prismatic joint to show the backward movement in static position without any 

rotational angle. 

A few problems occurs to determine the joints between the Follower and double 

thread because as said before that the double thread detect as a whole. So, to 

determine the mechanism is impossible. As the solution, the author decide to use a 
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linear movement of the Cam while rotating using Prismatic and Revolve Joints. The 

length and pitch of the movement is based on calculation that is 150mm and 15 pitch 

meanwhile the rotational angle for revolve joints are determined by mathematical 

calculation that are 15 pitch X 360 degrees/pitch = 5400. By this calculation the 

movement of the Follower are smoothly move on the Double Thread path. Lastly, the 

author would like to conclude that this project had meet all objectives. 

5.2 Recommendation 

Due to the time constraint and unavailability of skilled personnel, several 

information such as coincident between the Double Thread and Follower were 

unable to be obtained. So the position were assume between the Moving Bristle and 

Drive Bristle using suitable length, hence it is recommended for further in-depth 

research and simulation of the Double Thread, to show if it can be used for reverse 

and forward movement.  By using DMU Kinematics simulation with laws, the results 

will be more accurate and efficient. Other than that correlating the calculation result 

with the simulation are hardly to be apply since there are lack of knowledge in 

CATIA Simulation software. The author recommended that with an availability of an 

expert will improve the efficiency of this project since this project has a huge 

potential to be used by oil and gas industries. 
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